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Note
Screen shots shown in this User’s Guide are intended for illustrative purposes only.
The actual text and values that appear on display may differ from the examples shown in this

User’s Guide.



Getting Started

» fx-9860G Manager PLUS is an emulator that lets you perform fx-9860G operations on your
computer.

* You can record key operations you perform on the emulator as “Key-Log records”, and edit Key-
Log records as required.

* The keys on the Key-Log editor screen as well as the emulator LCD screen contents can be
pasted into other applications. This means that emulator data can be used to create assignments,
tests, and other materials.

* A presentation feature lets you play back saved Key-Log records.

* You can connect your fx-9860G unit to your computer and display its contents on your computer
screen.

Important!

* Be sure to install the fx-9860G Manager PLUS before you connect fx-9860G to your computer.
Connecting before you install the fx-9860G Manager PLUS can result in improper operation.

B Using This Manual

* This manual covers the software included on the fx-9860G Manager PLUS CD-ROM. For details
about operation of the fx-9860G Graphic Scientific Calculator, see the user documentation that
comes with the calculator.

* The procedures in this manual assume that you are already familiar with the following standard
computer operations.

- Menu operations using the mouse, including: clicking, double-clicking, dragging, etc.
- Text input using the keyboard
- Icon operations, general window operations, etc.

- If you are not familiar with these types of operations, refer to the user documentation for your
computer.

* The screen shots shown in this manual are all from the English version of Windows XP.

* Note that the actual appearance of the screen that appears when using this software depends on
your computer system setup and on the operating system you are using.
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1. Installing and Uninstalling fx-9860G
Manager PLUS

This section explains how to install and uninstall fx-9860G Manager PLUS.

To install fx-9860G Manager PLUS

1. Place the CD-ROM into your computer’s CD-ROM drive.
e After a short while, the fx-9860G Manager PLUS screen will appear on the display.

I fx9860G ManagerPLUS

fx-9860G Manager PLUS

O View Owmr Website

() Exir

CASIO COMPUTER CO, LTD.

The following describes what each item on this screen does.

fx-9860G Manager PLUS ... Installs fx-9860G Manager PLUS.

fx-9860G user’s guide ... Opens the fx-9860G Manager PLUS User’s Guide.

OS update ver.1.03 ... Updates the operating system of an x-9860G calculator to Version 1.03.

Add-In Application ... Displays the add-in application screen, which shows folders that contain
add-in applications and provides access to add-in application documentation.

View Our Website ... Goes to the website at http://world.casio.com/edu/
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2. Click “fx-9860G Manager PLUS".
* This displays the screen shown below.

I x9B60G ManagerPLUS

fx-9860G Manager PLUS

CASIO COMPUTER CO, LTD.

The following describes what each item on this screen does.

INSTALL ... Starts installation of fx-9860G Manager PLUS.
fx-9860G Manager PLUS user’s guide ... Click a language to open the corresponding
user’s guide.

3. Click “INSTALL”.
* This displays a language selection menu.

Choose Setup Language |E|

Select the language faor this installation from
the choices below,

Ok I Cancel

* The option you select here specifies the language of the screen text that appears during
installation. The screen text language of the £x-9860G Manager PLUS application itself is
English, regardless of what you select here.

* Selecting English, Spanish, or German here will cause the corresponding language’s
fx-9860G Manager PLUS application user’s guide to be installed. Selecting any other
language will cause the application’s English user’s guide to be installed.

¢ The fx-9860G calculator user’s guide that is installed will be the language that you select here.
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4. Select a language and then click the [OK] button to advance to the next screen.
¢ If the [Next] button appears, click it.
e This displays the end user license agreement (EULA).

fx-9860G Manager PLUS Setup

Licenze Agreement
Please read the fallowing license agreement carsfully.

Press the PAGE DOWH key to see the rest of the agreement.

This is the Licenze Agreement that vou have already read and agreed before instaling
[copying] this software [f+-9860G Manager PLUS). Please read it for reconfimation. If pau
didn't read thiz License Agreement before installing [copying) this software (f2-3860G
tdanager PLUS), and you do not agree to the terms of this Agreement, vou may, within 15
days, return the media package and the order items [including written materials, binders ar
other containers, if any) which are part of thiz product to the place where you obtained

them for a full refund.

CASI0 COMPUTER CO., LTD.
License Agreement and Limited 'w arranty. v

Do pou accept all the terms of the preceding License Agreement? |f you choosze Ma, the
setup will close. Toinstall f4-9860G Manager PLUS, you must accept this agreement.

< Back Yes Na

5. Carefully read the EULA.

6. If you agree to be bound by the terms and conditions of the EULA, click [Yes].
This will display the user registration screen.
e If you do not want to agree, click [No] to exit the installation operation.

fx-9860G Manager PLUS Setup

User Information

Input the installation key associated with your user name and product, and then click the [Mext]
buttar,

User Mame |

Installkey |

< Back Cancel |

7. Input the appropriate information in the following boxes and then click [Next].

User Name ... Input your name.
Installkey ... Input the Install Key sticker number on the software package.
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fx-0860G Manaeger PLUS Setup

Choose Destination Location
Select folder where Setup will install files.

Setup will install fx-98B0G Manager PLUZ in the following folder.

To install to this folder, click Next. To install to a different
folder, click Browse and select another folder.

Destination Folder

CivProzram Files

< Back | Cancel ‘

8. Perform either of the two following steps to specify the installation drive and folder.

¢ To use the default settings
Simply click the [Next] button.

* To specify a different folder
Click the [Browse...] button. Select the folder you want and then click [Next].

9. Click the [Next] button to start the installation.

fx-9860G Manager PLUS Setup

InstallShield Wizard Complete

Setup has finished installing F2-98B0G M anager PLUS on your
computer.
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10 When a message appears telling you that installation is complete, click the [Finish] button.
* This completes installation.

Note
¢ Installing the software will put a “9860Manager+” shortcut icon on your Windows desktop.

To uninstall fx-9860G Manager PLUS

7. Display the Windows Control Panel.
. Click [Add/Remove Program].

2
3. On the list of applications that appears, select “fx-9860G Manager PLUS”.
4

. Click the [Add/Remove] button.
e This will display the program maintenance wizard.

5. Click the [Yes] button.
* This completes the uninstall operation.

To start up fx-9860G Manager PLUS

1. On your computer’s desktop, click the “9860Manager+” icon.
* You could also start up the application by clicking [Start] - [Program] - [CASIO] - [fx-9860G
Manager PLUS] - [fx-9860G Manager PLUS].

I.E'%,

=]
A
Manager+
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2. Screen Configuration

The following shows the x-9860G Manager PLUS screen.

T fx-9B60G Manager PLUS - [Editor Mode] - DispCap2

Menu Bar File Edit Viewn Keylog Window Took Help
Ded SE 5 RE v o @m &
Toolbar _E EXCIEE B
CASIO f-9860G SD
123x456
e v S o ot
OOoOOYOew
Emulator —| il DD @
AT
.@ﬂm@@
oFwE Mo cUp N mSTE O INS B pispCap2 [ %)
200 L
u-a-a @4—4—4@
S Y . pEE E]._J Sy
Status Bar

File Display Area

* A pixel resolution setting of 1024 x 768 is recommended for your computer screen.

* When you have both the emulator window and Key-Log (or bitmap file) window open on the
display, the emulator window always will be displayed on top.



Menu Bar

* This section explains the fx-9860G Manager PLUS menu bar.

¢ If a menu command can also be executed by clicking a toolbar button, the applicable toolbar
button is also provided.

M File Menu

Heww Cirl+M
Open... Cirl+0
Close

Screen Cap

Save Cirl+5
Save Az

Frint... Citr[+P
Print Prewicm
Print Setup..

1 Keylogdelk
2 Keyloe3elk

3 Keylos2elk — File History

4 Kevlogl.elk ]

Exit

Menu ;c:lc::l;zr Description
New D Creates a new Key-Log file.
Open ﬁ- Opens an existing file.
Close Closes the currently open file.
Screen Cap % Captures the emulator screen.
Saves the current work file, overwriting the previous

Save n (unedited) version. ’ P
Save As Saves the current work file under a new name.
Print & Prints the currently displayed bitmap file.
Print Preview @ Displays a preview of the print image.
Print Setup Displays the print setup dialog box.
(File History) Shows up to four of the last files you worked on.
Exit Exits fx-9860G Manager PLUS.

E-9



M Edit Menu

Undo
Redo

Cut
Copy
Paste

Clear

Cir|+2
e+

Crl+¥
Cir |+
Cir [+

Del

Select Al Ctrl+é

Menu ;‘:::tl::r Description
Undo K7 Undoes the last operation.
Redo il Redoes the last undone operation.
Cut 33 Cuts the currently selected screen area and places it onto
the clipboard.
Copy Copies the currently selected screen area to the clipboard.
Paste @ Pastes the clipboard contents.
Clear Deletes the currently selected area.
Select All Selects all Key-Log records.

* The Edit menu is disabled during emulator operation.




M View Menu

1| Haormal
Calc Screen >—|_ Laree
Tool Bar r wxl
w2
x3
xd
L]
« atandard
v Log
« Edit
« Bitmap
Menu Submenu Description
Calc Key Normal Selects normal-size calculator keys.
Large Selects large-size calculator keys.
Calc Screen x1 Specifies an actual size display.
x2 Specifies a 2X size display.
x3 Specifies a 3X size display.
x4 Specifies a 4X size display.
x5 Specifies a 5X size display.
Tool Bar Standard Toggles display of the standard toolbar on and off.
Log Toggles display of the log toolbar on and off.
Edit Toggles display of the edit toolbar on and off.
Bitmap Toggles display of the bitmap toolbar on and off.




B Key-Log Menu

Emulator mode

Key-Log editor mode

Add
Delete
v Emulator Ernulatar
Editor v Editor
Auto Play Auka Play
Step Play Skep Play
Record Record
Insert Pause
Toolbar A
Menu Button Description
Add Q Adds a new Key-Log record.
Delete & Deletes the currently displayed Key-Log record.
Emulator i Enters the emulator mode.
Editor % Enters the Key-Log editor mode.
Auto Play - Starts Key-Log auto playback.
Step Play | 2 Starts Key-Log manual playback.
Stop | Stops Key-Log playback or recording.
Pause ] | Pauses Key-Log playback.
Record ] Starts Key-Log recording.
During Key-Log editing, inserts a pause character into
Insert Pause () g7y og g P

Key-Log playback.




B Window Menu

Harizontal
Menu Description
Tiled Displays all windows in a tiled configuration.
Horizontal Displays all windows in a horizontal line.

* The Window menu also shows the names of files that you have open. When you have multiple
files open, the file name at the top of the list is the one you are currently working with the active

file.

H Tools Menu

Tools

Screen Receiver

Options..
Toolbar _—
Menu Button Description
Screen Receiver Starts up Screen Receiver.

Options

Displays a dialog box for configuring optional settings.

H Help Menu

Calculator

License Manager PLLIS
About [
Menu Submenu Description
Manual Calculator Displays the fx-9860G Graphic Scientific Calculator
User’s Guide.
Manager PLUS | Displays the fx-9860G Manager PLUS User’s Guide.

License Displays the end user license agreement.
About Displays version information.




Toolbar

* This section explains the fx-9860G Manager PLUS toolbar buttons.

¢ The toolbar buttons correspond to menu bar commands. See the section of this manual that
explains the menu bar for details about each button’s function.

M Standard Toolbar

Al 2 NACR R LI IR

New Open Save Print Print Cut Copy Paste Undo Redo Screen Emulator
Preview Receiver

B Record/Playback Toolbar

D EI1 &

e N

Play Step  Stop Pause Record

B Key-Log Editor Toolbar
5 G @ |Arial ‘ v

v | |Data1 v

|
(ORCINE) @ ® ®

@ Add

@ Delete

@ Insert Pause

@ Font ... Specifies the font of input text.

® Font Size ... Specifies the font size of input text.

® Key-Log Record ... Selects the Key-Log record to be played back or edited.



H Bitmap Toolbar

Tﬁ+||_—| xl W

® @ &)

@ Screen Cap

@ Outer Frame
Specifies an outer frame for screen captures.

@ Bitmap Size

Specifies the bitmap size. A setting of 1 through 10 can be selected.

Status Bar

Copies the selected data to the cipboard,

@

(D Help text is displayed here.
@ Displays the process currently being performed.
@ Toggles between the insert and overwrite modes.

Clicking here while in the Key-Log editor mode toggles between the insert mode and overwrite

mode.



3. Emulator Mode and Key-Log Editor Mode

fx-9860G Manager PLUS has two modes.
You can use either of the following to operations to select the mode you want.
* On the [KeyLog] menu, select either [Emulator] or [Editor].

+ On the standard toolbar, click @ or G, .

Emulator Mode

Use this mode when you want to perform mainly emulator operations.
Key-Log Editor Mode

Use this mode when you want to perform mainly Key-Log data operations.



4. Emulating fx-9860G Calculator Operation

* The emulator makes it possible to mimic fx-9860G calculator operation using your computers
mouse and keyboard.

* For details about emulator operations, see the fx-9860G User’s Guide. You can view the User’s
Guide by selecting [Manual] - [Calculator] on the Help menu.

¢ Note that some emulator functions are different from the functions of the fx-9860G calculator. For
details, see “9. Differences between fx-9860G Calculator and x-9860G Manager PLUS
Functions” (page E-33).

B Using the Emulator

* Key operations are identical to those you perform on the calculator.
* Operation results appear on the LCD screen.

§5 fx-9860G Manaser PLUS — [Emulator Mode] — Keyloel
File Edit Wiew Keylos lWindow Tools Help

0eW 2 = [«

CASIO fx-9860G SD

MAIH MEHL W
s‘rﬁT em:

GRHPH DYNH THBLE F:ECLIR LCD Screen
COHICS [EqUR  [FRGM [TWH
@Lﬂﬂw

USB POWER GRAPHIC

e Zoom VWindow Skeich GSolv  GeT

_J._J-_J-_J_)_)

PRGM  SET UP
BHOK v I % & qur
DD

A 1078 et

X.eT
Dooooo Keypad

ODOVOO

CPTIRE M CUP_ N PASTE O

ﬂﬂ@ [

00COD

In the Emulator Mode, you use your computer keyboard to operate the emulator. The following
explains the keyboard keys you should use to perform each emulator key operation.

(1) Computer keyboard keys that have the same key markings as the emulator keys

@_@7 B« 7 Bu 1 1 @7 7 @_7 @1 ®1 @1 @



(2) Computer keyboard keys that have different key markings as the emulator keys

Computer Key Emulator Key
[Tab]
[Insert]
[Home]
[Page Up] VARS]
[Page Down] [END)
[End]
[Esc]
[Delete]
[Back Space]
[Enter] Eg
[ 3
1 =

B Changing the Size of the Emulator

You can select one of two sizes for the emulator’s keypad and one of five sizes for the display area.

To specify the size of the keypad

1. On the [View] menu, select [Calc Key].
2. From the submenu that appears, select the keypad size you want.

To specify the size of the LCD screen

1. On the [View] menu, select [Calc Screen].

2. From the submenu that appears, select the LCD screen size you want.



B Moving the LCD Screen Area and Keypad

* You can drag the LCD screen and the keypad to any location you want on your computer screen.

&, fx-9860G Manager PLUS - [Emulator, Mode]
Fle Edt Vew Keylog Window Teds Heh

el SR 4BEE[o~ @MR\

|5 & @ [~ ata |

IO TE
fx-9860G SD

t MATH_ MEML s
FTRT [BACT(E2HT

P )
GRRPH DYNR TRELE [RECUR
comcs Eaun PRGM TUM

B Using the Floating Emulator Feature
* You can display the emulator LCD screen and its keypad in their own windows that are separate

from the fx-9860G Manager PLUS window.
To make the LCD screen a floating window
1. Double-click the LCD screen.

2. Drag the LCD screen to the left so it is outside of the main application window, and drop it there.

T fx-9B60G Manager PLUS - [Emulator Mode]
File Edt View Keylog Window Tools Help

D@H 53 iBE v E\J\R\
8 & @|ail

fx-9860G SD

% MATH NENU //////
ETAT |ef T

7 L ]
GRAFH [I7HA | TABLE |RECUR
b Ml gl

CONIES |y PRGM TUM




To make the keypad a floating window
1. Double-click the keypad.

2. Drag the keypad to the left so it is outside of the main application window, and drop it there.

T fx-9B60G Manager PLUS - [Emulator Mode]
Fle Edt Vew Keylog Window Tools Hep
0o o @[«

fx-9860G SD

MATH MENL #
STAT [2ACT [S-SHT

GRRPH‘ %TRLE mam
@é_ﬁl e

B Moving the LCD Screen and Keypad Back into the Main Window
 Perform the following steps to move the LCD screen and/or keypad back into the fx-9860G
Manager PLUS main window from independent floating windows.
- Double-click the floating LCD screen and/or keypad.
- Drag the LCD screen and/or keypad back to the left side of the fx-9860G Manager PLUS main
window.

Important!

* You can return an independent floating window to the main window by dragging the floating
window to the left side of the main window only. Dragging top, bottom, or right side of the main
window will not work.
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H Capturing the Emulator LCD Screen Image
* You can use the following procedure to capture an image of the emulator LCD screen.

To capture the emulator LCD screen image

7. On the [File] menu, select [Screen Cap] to display a capture of the emulator LCD screen.

* You could also click g on the bitmap toolbar.

& x-9860G Manager, PLUS ~ [Emu Mode] — DispCapl

File Edit View Keylog Window Tor

Ded S84 B

e [ [ |
BEX
|ist 1 |uist 2 uist 3]0 i Litt 2
<UB

2 2|
El 3| ool 1]
y B0
16 uoo
[P CALCITESTATHTR OIS T I 500

800
166
GRPHACALCITESTIHTR 0TS T ] I

* You can also add a frame to the captured image or change the image zoom factor, if you want.

For details, see “Bitmap Toolbar” (page E-15) and “LCD Screen Capture Settings”
(page E-28).

* |f either a window containing of a captured image or the Key-Log screen is currently
maximized (using the Windows maximize command) on your computer display, any window
produced by the capture operation will also be maximized. This is true regardless of the size
setting specified for screen capture on the Options dialog box (page E-28).

2. Select the captured screen image window and then click n to save it to a file.

* You can save a screen capture as either of the two following file formats.
¢ Monochrome bitmap format
¢ JPEG format

This application uses libraries by the Independent JPEG Group.
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B Opening a Saved LCD Screen Image
* You can open a saved LCD screen image and display it on your computer. You can have multiple
screen images open at the same time.

* LCD screen images can be copied and pasted into other applications in order to create operation
example handouts, assignments, etc.

* Only bitmap files can be opened using this procedure. Opening of JPEG files is not supported.
To copy an LCD screen image and paste it into another application
1. Click [z@= and then open the file that contains the LCD screen image you want to copy.

2. Select the LCD screen image window and then click to copy it to the clipboard.

3. Open the other application and then paste the contents of the clipboard.
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5. Using the Emulator Key-Log

This section explains how to use the Key-Log, which is a log of the emulator’s key operations. It
also covers playback of recorded key operations and editing of Key-Log records.
All of the operations in this section are performed using toolbar buttons.

B Key-Log File Structure

A Key-Log file can contain multiple Key-Log records.
Key-Log records contain recorded key operations and text.
The following shows the Key-Log file structure.

Key-Log File

Key-Log Records

|__— Key

1 | |EXE

Mathematics

[ Text Data

y

* You can assign names (up to 20 single-byte characters) to Key-Log records.

Important!

* Key-Log data processing can take a long time when there is a lot of data. This is normal and does
not indicate malfunction.

* Only key operation procedures are stored in a Key-Log file. Because of this, replaying Key-Log
contents starting from an initial screen that is different from the one that was displayed when the
data was originally stored may produce different results.

* A key operation may not be stored to a Key-Log if you click it while an emulator calculation
operation is in progress.
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To record emulator key operations using Key-Log

1. Click ## to start Key-Log recording.

2. Perform operations on the emulator.

¥ fx-9860G Manager PLUS - [Editor Mode] - Keylog1

Flo £k Viow Kertoo Widow Toos Help
Nead 56 156w B ¢ -
O& ® [cro = v muela@a v

CASIO EER

123x456 @@@@@@@@

3. Click Il to stop Key-Log recording.

4. Click n to save the Key-Log file.
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To perform Key-Log auto play of a recorded key operation

1. Click [z@= and then open the Key-Log file you want to play.

2. Click - to start playback.

The next key to be Played key operations
played back is orange. are blue.

¥ 1x-9860G Manager PLUS - [Editor Mode] - Keylog1

Fie Edt View Keylog Window Tools Help
C@edSE[4hmoo m <R
& @

cAsio 198606 SD

123%456

The last played
key is blue. The next key to be played is framed in orange.

« Click Il to pause playback.
Click | to restart playback after pausing it.

3. To stop playback, click [l . Stopping playback causes all keys to return to their original colors.

Note

* You can use the optional settings dialog box (page E-28) to configure playback settings like the
key playback interval following a pause, the color of playback keys, etc.

» Simultaneous playback of multiple Key-Log files is not supported. If you try to open a Key-Log file
while another Key-Log file is already open, the currently open file will close automatically. If the
currently open file has been edited, a message will appear asking if you want to save it before
closing.

fx-9860G Manager PLUS

Save edits?

? ) Atleast one file has unsaved edits,

[ Yes ][ Mo l[ Cancel ]
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To playback a Key-Log record manually (STEP playback)

1. Click [z@= and then open the Key-Log file you want to play.

2. Click [ to play the first key operation in the Key-Log.

3. Keep pressing |p to play Key-Log contents one step at a time.
4. 10 stop playback, click I .

To edit a Key-Log record

7. Click [@@ and then open the Key-Log file you want to edit.

2 . Select the Key-Log record you want to edit.

& & @ Al v|[24  |v||Datal

Select the Key-Log record from this menu.

3. Edit the key operations and text of the Key-Log record.

* You can use normal text input and editing operations to edit the keys in a Key-Log record.

* When inputting text, you can specify the font and font size you want to use.

L & @ [Arial v [24 g (¥ [Datal
Font Font Size

4. ciick [ to save the Key-Log file.
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To add a Key-Log record to the currently open Key-Log file
After opening the Key-Log file to which you want to add the record, click L.

This automatically assigns the Key-Log record a name (Example: “Data1”) and displays it in the
menu.

To rename a Key-Log record

7. Select the Key-Log record you want to rename from the menu.

2. Click the name of the Key-Log record and then change it.

3. Press the [Enter] key.

To delete a Key-Log record

7. Select the Key-Log record you want to delete from the menu.

2. Click L to delete the selected Key-Log record and display the next one.

Note

* There must be at least one Key-Log record in memory. You will not be able to delete a Key-Log
record if it is the only one left in memory.

Ml Inputting a Pause Character
A pause character causes Key-Log playback to pause automatically when it reaches the character.

To input a pause character, click (I}

H Copying Keys or Text and Pasting It into Another Application
Keys and text can be copied and pasted into other applications in order to create operation
example handouts, assignments, etc.

To copy keys or text and paste it into another application
7. Drag the cursor across the keys or text you want to copy.
2. Click to copy the selected keys or text to the clipboard.

3. Open the other application and then paste the contents of the clipboard.
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6. Configuring Options Dialog Box Setting

 This section explains the settings on the Options dialog box.

B LCD Screen Capture Settings

E3

Options Dialog

“Sereen Capture | KeyLog

® Add a frame for screen capture.

During screen capture, display using size |1 w ®

(@ Select this option to add a frame to an LCD screen capture.
@ Specifies the screen size during LCD screen capture. You can select a setting
in the range of 1 through 10.

B Key-Log Playback

Options Dialog, E]

Screen Capture| Key-Log |
@ Show the curent key during Key-Log play.
@ Show the nexst key operation during Key-Log play.
@ [ Atter pausing, resume after minutes seconds elapse
Play interval | 2+ | seconds
@

@ Select this option to highlight the current key in blue.
@ Select this option to frame the next key in orange.

@ Specifies how much time should be allowed to elapse to resume paused playback. You can
set an interval in the range of 10 seconds to 10 minutes in 10-second steps.

@ Specifies the key playback interval during auto play. You can set an interval of 0.1 second, or
any interval in the range of 0.5 to 5 seconds, in 0.5-second steps.
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7. Other Functions

Printing

* You can use the following procedure to print LCD screen captures.
7. Click the window of the LCD screen capture that you want to print to select it.

2. Click ¢=5. This will display the Print dialog box.

Print

Frinter

Mame: | AGFA-AccuSet vE2.3 v
Status: Feady

Tuype: AGFA-ACcuSet vB2.3

Where:  LPTT:

Comment. [ Print to file
Frint range Copies

@ Al Mumber of copies: £

EEEEEE

3. Click [OK] to start printing.

Important!
* Each screen image is printed on a separate page.

* Images are printed in accordance with width setting of the paper size selected on the Print dialog
box.

Examples: Portrait Orientation Landscape Orientation

7@ FIAIH MEML #esm

STF|T EHCT SSHT .

GRAFH |DVHA |TAELE |RECUR & HHIHErgE'IHU R
_é_é_éﬂé (B -féﬂ'd

COHICS|EQUA  FRGM [TUH 1 = E
iglé?é.;.* assFF ! GRHPH nvnﬁ TRELE |RECUR

EGHICQEQUH Aﬁ -Q;tl?F d\l-

e If you are printing a bitmap image that was created using another application and does not fit
within the preview area, only the part within the preview area will be visible. Also, only that part
will be printed. E-29



M Print Preview
» Selecting [Print Preview] on the [File] menu displays the print preview image.

@

A TN MENL 7277

(D Displays the Print dialog box.
@ Enlarges the preview image.
@ Reduces the size of the preview image.
@ Closes the print preview window image.

B Print Setup Dialog Box
» Selecting [Print Setup] on the [File] menu displays the Print Setup dialog box.

Print Setup

Frinter
Status: Ready
Type: AGFA-AccuSet vB2.3
where:  LPTT:
Comment:
Faper Orientation
Size: | Letter R | (&) Portrait
Iy
Source: |Autumalically Select L | O Landscape
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Shortcut Menu

* Right-clicking the mouse displays one of the shortcut menus shown below.

* During Key-Log Editing

Undo

Cut
Gopy

Clear
Select All

 During Bitmap Display of the Calculator B DispGapt
Screen
TRCE AT

A screen zoom operation affects only the screen where
you display the shortcut menu. If you have multiple
screens on the display, the other screens are not affected
by the zoom operation.

¢ When Using the Emulator CASIO f%-9860G SD ‘

Screen Cap

e Zoom VWindow Sketch GSolv  GeT

q_)_)q_)_)

« bormal [
Loree
iy o

Yoo bk B L

@Illlﬂﬂ

CFRE M CUP_ N PASTE O NS

[ 8 1 o Joet Jace)

camos P

BBBE

U Mat v

7 = SPACE T

ob@o@

* On the Emulator Keypad
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8. File Types Supported by fx-9860G Manager
PLUS

* fx-9860G Manager PLUS supports files with the file name extensions described below.

Extension Description
gim Emulator or calculator user memory data file (variables, programs, etc.)
gle eActivity file
gla Add-in application
g1k fx-9860G Manager PLUS Key-Log file
Note

* You can use the MEMORY application to import all file types (except g1k) into the emulator.
* Files with the extension g1k can be used in Key-Log files.
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9. Differences between fx-9860G Calculator
and fx-9860G Manager PLUS Functions

¢ This section explains the differences between fx-9860G calculator functions and x-9860G
Manager PLUS emulator functions.

H eActivity Applications (SD Card Access)

Calculator: SD card access supported.

Emulator: Performing an operation that accesses an SD card displays a dialog box, which can be
used to open an eActivity saved on your computer or save an eActivity on your
computer. Trying to perform an optimize operation while accessing an SD card will
cause an error.

Example: To use the emulator to create a new eActivity file (ABC.g1e) on an SD card (actually
your computer’s hard disk)

1. From the Main Menu, enter the e-ACT mode. cASS P D 1
efAct List [ ]
Mo Files

HELL
USB POWER GRAPHIC

fx-9860G SD

2. Click F8)(SD).
* This displays the SD access screen.

eAct List [

(FEHAHE)

I
USB POWER GRAPHIC J

fx-9860G SD

3. Click F2(NEW).
* This displays a file name input dialog box.

=Act List

PRGM  SETUP
W W
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4. Select the location on your computer where you want to save the file, input the file name

(ABC.g1e), and then click [Save].
fx-9860G SD

* This displays the eActivity file editing screen.

FILE TERT MIP[Real &

USB POWER GRAPHIC

* Subsequent operations are identical to those you would perform on the calculator.
* After you are finished, perform the required operation to save the file.

Example: To use the emulator to open an eActivity file (ABC.g1e) that is stored on an SD card
(actually your computer’s hard disk)

7. From the Main Menu, enter the e-ACT mode. j
CASIO fx-9860G SD

r

eAct List

Mo Files

HEW
USB POWER GRAPHIC

fx-9860G SD

2. Click [Fg)(SD).
* This displays the SD access screen.

eAct List [

(FEHAHE)

I
USB POWER GRAPHIC J

f%-9860G SD

3. Click [F1)(OPEN).
* This displays a file selection dialog box.

eAct List [

Loak i | () My Document ts

By e

OPEHJHE L

Fils oftype: 6439806 flos (. gle]

PRGM  SETUP =
DDD
RERLAY

Blok v r & & our (B ¥

4. Type in the file name (ABC.g1e), and then click [Open].

* This displays the eActivity file editing screen.
E-34



B LINK Application

Calculator: Data transfer execution supported.

Emulator: Data send/receive, and configuring cable, wakeup, and capture settings are not
supported. Attempting to perform any of these operations causes an error.

B MEMORY Applications (SD Card Access)

Calculator: Data save to and data read from an SD card supported.

Emulator: Performing an operation that accesses an SD card displays a dialog box, which can be
used to store data to a computer file and to import a file.
Trying to perform the SD card optimize operation on the emulator will cause an error.

SD card (actually your computer’s hard disk) access can be performed by selecting
either a folder or a file. What you select depends on the type of operation you want to

perform.

When to select a folder on your computer’s hard disk

Select a folder on your computer’s hard disk when you want to perform any one of the following

operations.

* Copying main memory or storage memory contents to an SD card (actually your computer’s hard

disk)

* Loading backup data from an SD card (actually your computer’s hard disk)
* Saving backup data to an SD card (actually your computer’s hard disk)

Example: To use the emulator to save backup data to your computer

1. From the Main Menu, enter the MEMORY mode.

2. Click F2)(BKUP) 1) (SAVE).
* This displays the save location selection screen.

E-35

fx-9860G SD |

Memory Manager

Fl:Main Memorw

FZ2:Storase Memor:»

F3:SD Card

F4 Backup
L1m1zaL1Dn

[HAIHEMERE S DUJERIPJOF T

USB POWER GRAPHIC

fx-9860G SD

L
Sawe Lo

SLorase Memi[1]
] 5D Card 2]

F
376256 Ewles Free
[5AUE JLOAD ]

USB POWER GRAPHIC J




3. ciick @.
* This displays the folder selection screen.

fx-9860G SD

Save Lo

Slorase Mem:
ard

Fk
376256 Brles Fiy
[SAUEJL D ]

43 e s
(3 F9B5065ingle20050518

USB POWER GRAPHI

Zoom V-Window Sketch G

\_) OEEEED

PRGM szrup
DY or™ ) vars

4. Select the folder you want and then click [OK].
* The backup data is saved to the folder you select.

When to select a file on your computer’s hard disk
Select a file on your computer's hard disk when you want to perform the following operation.

* Copying a file on an SD card (actually your computer's hard disk) to main memory or storage
memory

1. From the Main Menu, enter the MEMORY mode.

Memory Manager

fx-9860G SD
Fl:Main Memor:

F2:Storase Memor:w
F3:5D Card
Fd:EBackur .
FaiOrtimizat.ion
HAIREME) = OUJERIPJOR T

USB POWER GRAPHIC

2. Click [3)(SD).

* This displays the file selection screen.

fx-9860G SD

Memory Managser

Fl:Main Memor

PRGM  SET UP

[

sl = T~ Yor)

3. Select the file you want and then click [Open].

* This displays the main memory/storage memory selection screen.
* Selecting a destination (main memory or storage memory) will start the copy operation.
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B SYSTEM Applications (Contrast, Auto Power Off, Reset)

Calculator: Contrast adjustment, auto power off setting configuration, and SD card formatting

supported.

Emulator: Contrast adjustment, auto power off setting configuration, and SD card formatting not
supported. Attempting to perform any of these operations causes an error.

M Installing an Add-In

You can perform the following procedure on the emulator to install an add-in application, add-in

language, or an eActivity.
Example: To install an Add-in application

1. From the Main Menu, enter the MEMORY mode.

2. Click {3(SD).
* This displays a dialog box for opening a file.

3. Select the add-in file you want and then click [Open].

4. ciick @.

5. click @ .

6. Click @m.
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Fl:iMain Memor:»
F2iStorage Memory

: Card
Fd:Backur .
FoilrLimizat.ion
(MR

ErEry S O JERIPJOFT)

B
Lok ir: | () My Document s DEN: ==
My Music
Ery pictures
Fierame: |
Fies of type: | 38605 fles (.17 v

M ¥}

Ll

Cop» Lo

F
Fl HMain Mem fL11]
F' Storage Memi[2]
FS:0FTimization

EHER] S D JERIEJOF T

A

Ed

r

F
F
F
F Srrmrererree -
Fo:OrLimization

EHEFE S D JERUEJOPT)

Ed

=

Comrlete!l
Pressi [EXIT]

5:0ptimization
[HAIREMER] S D JERVEJOPT,




/. Click [

* The icon of the application you just installed should be W FIFIIH r“'IEHLI /W
visible on the Main Menu. SR i T

* Some add-in applications may act differently on the fx-9860G calculator than they do on the
emulator.

B OFF (G + (9)

Calculator: Turns off power.
Emulator: Does not turn off the emulator. ( () + does not perform any operation.)

l COPY & PASTE

Calculator: COPY & PASTE supported on the calculator.

Emulator: COPY & PASTE supported on the calculator, and between the calculator and other
applications running on the computer. Note, however, that in the case of spreadsheet
formulas and values, copy and paste of the values only is supported. Copy and paste of
error data is not supported.

Copy and paste of fx-9860G calculator-specific input codes between fx-9860G Manager PLUS and
other applications is not supported in some cases. Windows 98 in particular is not able to display a
relatively large number of input codes. Because of this, use of Windows Me, 2000, or XP is
recommended.
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10. Using Screen Receiver to Display the
Calculator Screen Image on
Your Computer

This section explains how to connect an x-9860G calculator to a computer and display the

calculator screen image on the computer.

Important!

* Check to make sure that the operating system version of the fx-9860G calculator is 1.02 or
greater. If it isn’t, you will need to update your operating system. For details, see the information
about updating the operating in the readme.txt file on the fx-9860G Manager PLUS CD-ROM.

* A USB driver install dialog box will appear the first time you connect the fx-9860G calculator to
your computer with the USB cable. Follow the instructions that appear on the dialog box. Screen
Receiver will not operate properly if you cancel the install operation.

B Configuring fx-9860G Communication Settings
Before you can connect the calculator to your computer, you first need to perform the following
procedure and configure the calculator’s communication settings.

To configure the fx-9860G calculator communication settings

7. From the Main Menu, enter the LINK mode.

2. Press [F4)(CABL).
* This displays the Select Cable Type screen.

3. Press (F1(USB).

4. press (Fg) (CAPT).
* This displays the Capture Set Mode screen.

5. Press [[3)(OHP).

* This displays the screen shown nearby, which indicates Commuanical.ion
that the setup procedure is complete. Cable Tvee EHSB

llakeur f0n
Carture t0HP

ITTTT [RECT CAELY.IAKE]CHF T
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To display the calculator screen image on your computer

7. Use the USB cable that comes with the calculator to connect the calculator to your computer.

2. On the [Tools] menu, select [Screen Receiver], or click on the toolbar.

3. A short while after Screen Receiver starts up, an image of the calculator screen will appear on
your computer.

Screen Receiver

Screen Receive  Wiew  Help

GRAFH |[OvHA

4. Operate the calculator. When you do, the calculator screen image will change in real time on
your computer.

5. You can enlarge the calculator screen image by clicking Q and reduce its size by clicking Q

6. To close the calculator screen image, click a .

7. Disconnect the USB cable.
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Important!

* If the calculator screen does not appear, try disconnecting the USB cable and then restart the
above procedure from the beginning. If the calculator screen still does not appear, check the
points described below.

If this is the problem: Do this:
The USB cable is disconnected. Reconnect the USB cable.
There are multiple calculators connected. Disconnect the other calculators so there is

only one left connected.

There is another CASIO product connected | Disconnect the other CASIO product.
with a USB cable.

The message “ICESG502” appears on the | Reinstall fx-9860G Manager PLUS.
Device Manager screen which indicates that

the USB driver is not installed correctly.

B Screen Receiver Menus

Screen Recel

Start Cirl+35

Stop  Gri+P Ctrl+E License... Manager PLUS...
Exit  Alt+F4 About... F1 I
« Toolbar xg
« Statuz Bar n
x4
b3l
il
%1
x8
x3
«10
Screen Receive Menu
Menu Toolbar Button Description
Start E Displays the calculator screen image.
Stop a Closes the calculator screen image.
Exit Exits Screen Receiver.
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View Menu

Menu Submenu Toolbar Description
Button

Expand Q Enlarges the calculator screen image.

Reduce Q Reduces the size of the calculator screen image.

Zoom* x1 Shows the calculator screen image in actual size.
x2 Shows the calculator screen image is x2 size.
x3 Shows the calculator screen image is x3 size.
x4 Shows the calculator screen image is x4 size.
x5 Shows the calculator screen image is x5 size.
x6 Shows the calculator screen image is x6 size.
x7 Shows the calculator screen image is X7 size.
%8 Shows the calculator screen image is x8 size.
%9 Shows the calculator screen image is x9 size.
x10 Shows the calculator screen image is x10 size.

Toolbar Toggles display of the toolbar on and off.

Status Bar Toggles display of the status bar on and off.

* The allowable zoom size is limited by the resolution of the computer.

Help Menu
Menu Submenu Description
Manual Calculator Displays the x-9860G Graphic Scientific Calculator
User’s Guide.
Manager PLUS Display the x-9860G Manager PLUS User’s Guide.
License Displays the end user license agreement.
About Displays version information.
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11. Error Message Table
H fx-9860G Manager PLUS

Message

Description

Required Action

An error occurred while
reading the file <file name>.
The file may be corrupted.

Wrong file format.

Check the file to see if it is
corrupted.

There is no more playable
data.

There are no playable keys to
the right of the input cursor.

Move the input cursor to the
left of the keys you want to
play back, and perform the
play operation.

You cannot delete all Key-
Log records.

Before deleting the selected
record, first add a new
record.

You are trying to delete all
Key-Log records, which is not
allowed.

To delete all of the current
records, first add a different
record. At least one Key-Log
record must be remaining in
memory.

This application cannot run
on this computer’s operating
system.

You are trying to run the
application under an operating
system that is not supported.

Run the application on a
computer that is using a
supported operating system.

<file name>
This file is read-only.
Use a different file name.

You are trying to save a read-
only Key-Log file after editing
or recording to it.

Save the Key-Log file under a
different file name.

A problem occurred while
adding a Key-Log record.
After confirming there is
enough memory capacity to
store the record, try again.

Some problem occurred while
adding a Key-Log record.

Make sure there is enough
free memory remaining to
complete the operation and try
again.

A problem occurred while
accessing the registry.

Make sure that you are logged
on with administrator
privileges.

A registry access error
occurred.

Make sure that you are logged
on with administrator
privileges.

A problem occurred while
writing to the file <file name>
because not enough disk
space is available.

Check the remaining capacity
of your disk and try again.

There is not enough disk

space available to save the file.

Make sure there is enough free
memory available and try
again.

This application cannot be
started up because the DLL
version is wrong.

This may be due to a problem
during installation.

Re-install the application.

Your computer has the wrong
DLL version.

Installation may have failed, so
re-install the application.
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Message

Description

Required Action

A problem occurred while
reading file <file name>.

The disk being read from may
be damaged or may not exist.
Check the disk and try again.

A problem occurred while
reading from a disk.

Check the disk for data
corruption and confirm that the
disk exists. Then try again.

A problem occurred while
writing file <file name>.

The disk being written to may
be damaged or may not exist.
Check the disk and try again.

A problem occurred while
writing to a disk.

Check the disk for data
corruption and confirm that the
disk exists. Then try again.

A problem occurred while
reading file <file name>.

The file may have been moved
or deleted.

A problem occurred when you
tried opening a file from the list
of previously opened files on
the File menu.

Check to see if the file has
been moved or deleted.

There is not enough memory.
Increase memory capacity and
try again.

There is not enough memory
to perform the operation.

Increase memory capacity and
try again.

A problem occurred while
launching the emulator.

Try re-starting the application.
If you still cannot launch, it
could mean that the emulator
is damaged. Update the
emulator or reinstall it.

A problem occurred during
emulator startup.

Try restarting the application.

If this does not work, it could
mean that the emulator is
damaged. Update the emulator
or reinstall it.

A problem occurred while
launching the manual (***.pdf)
viewer.

Download the viewer from the
site below and reinstall it.
http://www.adobe.com/
products/acrobat/readstep2_
allversions.html

A problem occurred during
manual viewer startup.

Download and install a new
viewer from
http://www.adobe.com/

products/acrobat/readstep2_

allversions.html.

The following characters
cannot be used in a Key-Log
record name.

N2

The Key-Log record name you
are trying to use contains an
illegal character.

The following characters are
not allowed in Key-Log record
names.

N2

A system error has occurred.
Exit the emulator and restart it.
If this does not correct the
problem, it could mean that the
emulator file is damage.
Reinstall the emulator.

Follow the steps that are
shown on the display and try
again.
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Message

Description

Required Action

A system error has occurred.

(1) Shut down all other
applications that you are
not currently using.

(2) Check how much free
space is available on your
computer’s hard disk.

(3) Exit the emulator and
restart it.

If this does not correct the

problem, it could mean that the

emulator file is damage.

Reinstall the emulator.

Follow the steps that are
shown on the display and try
again.

A problem occurred while
accessing the registry.

Check to make sure that the
emulator is installed correctly.

fx-9860G Manager PLUS
cannot be started up. The USB
driver is not installed correctly.

Reinstall the USB driver.

The path and/or filename
exceeds the maximum length
allowed by your Windows
operating system.

The number of letters in the
path or file name you specified
exceeds the allowable limit.

Shorten the specified path or
file name.

A problem occurred while
importing <file name>.

Note that import of a file
created on another model is
not supported.

Some problem occurred while
importing the file.

Make sure that the file was
created using a calculator with
the same model name as this
calculator.

A Key-Log file cannot be
created or opened while Key-
Log data is being played back
or recorded.

Stop playback or recording
and try again.

You are trying to create a new
Key-Log file or open an
existing Key-Log file while
Key-Log data is being played
back or recorded on the
calculator.

Stop playback or recording and
try again.

File Extension Error

The file you selected has an
invalid file name extension.

Make sure that the extension
of the file you are selecting is

bmp or jpg.

<path> Invalid Extension

The file path you selected has
an invalid file name extension.

Make sure that the extension
of the file path you are
selecting is bmp or jpg.

A problem occurred while
accessing the registry.
Check to make sure that the
emulator is installed correctly.

Some problem occurred during
registry access.

Re-installation of the emulator
is recommended.

A system error has occurred.
Exit the emulator and restart it.
If this does not correct the
problem, it could mean that the
emulator file is damaged.
Reinstall the emulator.

A system error occurred.

Re-installation of the emulator
is recommended.
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Message

Description

Required Action

Invalid File Name

You specified an invalid file
name.

Make sure that you are
specifying the file name
correctly.

Invalid Folder Name

You specified an invalid folder
name.

Make sure that you are
specifying the folder name
correctly.

Too Many Files Selected

The number of files you
selected exceeds the allowable
limit.

Reduce the number of
selected files.

H Screen Receiver

Message

Description

Required Action

A connection could not be
established.

Either the calculator is not
connected or the connected
calculator is not in the OHP
Mode.

Correct the problem and try
again.

For details, select the following
on the menu bar: Help -
Manual - Manager PLUS, or
refer to the Manager PLUS
user’s guide.

You started a data
communication operation while
the USB cable was not
connected.

Check for proper connection of
the calculator to the computer
and confirm that the calculator
is in the OHP mode. Then try
again.

See “10. Using Screen
Receiver to Display the
Calculator Screen Image on
Your Computer” for details.

A problem occurred during
communication.

Disconnect the USB cable,
check the setup of the
calculator, and try again.

For details, select the following
on the menu bar: Help -
Manual - Manager PLUS, or
refer to the Manager PLUS
user’s guide.

Some problem occurred during
data communication.

Disconnect the USB cable and
check the setup of the
calculation. Then try again.
See “10. Using Screen
Receiver to Display the
Calculator Screen Image on
Your Computer” for details.

Multiple calculators have been
detected.

To start communication, make
sure there is a USB connection
with a single calculator.

Multiple calculators are
connected to the computer.

Make sure that there is only
one USB connection to a single
calculator before starting
communication.

See “10. Using Screen
Receiver to Display the
Calculator Screen Image on
Your Computer” for details.
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Message

Description

Required Action

The image could not be sent

from the calculator.

(1) Try pressing a key on the
calculator.

(2) Check to make sure that
the calculator is in the OHP
Mode.

If the screen is not sent after

you perform the above steps,

disconnect the USB cable and
check the calculator setup.

Next, reconnect and try again.

For details, select the following

on the menu bar: Help -

Manual - Manager PLUS, or

refer to the Manager PLUS

user’s guide.

The calculator screen image
cannot be sent for some
reason.

Follow the steps that are
shown on the display and try
again.

See “10. Using Screen
Receiver to Display the
Calculator Screen Image on
Your Computer” for details.

The connection has been
broken for some reason and is
being restored.

If data communication does
not resume after some time,
perform the operation
described below.

Try pressing a key on the
calculator. If the screen is not
sent after you perform the
above steps, disconnect the
USB cable and check the
calculator setup. Next,
reconnect and try again.

For details, select the following
on the menu bar:

Help - Manual - Manager
PLUS, or refer to the Manager
PLUS user’s guide.

Follow the steps that are
shown on the display and try
again.
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CASIO.

CASIO COMPUTER CO., LTD.

6-2, Hon-machi 1-chome
Shibuya-ku, Tokyo 151-8543, Japan

SA0606-A
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